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1.0 INTRODUCTION - HOW THE RACETIME SYSTEM WORKS 
 

ERS RACETIME is a barcode based race timing system designed to provide running clubs and     
organisations with a low-cost means of electronically capturing athlete times and race results.  
 

The RACETIME system is designed for ‘single-stage’ races, with either ‘Mass’ starting of all athletes, 
or Individual or Group starting.  
 

The main system components are summarised below (see also system schematic on following 
page): 
 

• Athlete Timer  The Athlete timer is used to                 
capture the race start time (for  Mass start 
events) and to log the time when each                    
competitor crosses the finish line. 

 Two versions of the Timer are available: The 
 Standard Timer (based on the OPN2002 Data                         
 Collector), and the Advanced Timer (Based on 
 the CPT8200 terminal). The Advanced Timer 
 has the benefit of a display which shows a 
 ‘stop watch’ style timer, an athlete ‘counter’, and the last 10 captured finish times 
 

• Athlete Scanner Each competitor is allocated a unique barcoded ID when they register for the 
race.  On completion of the race the athletes will be scanned to identify their finishing                 
positions.  The Athlete scanner is based on the OPN2001 Barcode Data Collector)  

• RaceTime supports 2 scanning modes as follows: 
 

  1) Athletes may be scanned as they finish the race in finishing  
  order. This has the advantage of simplicity, however may result  
  in ‘crowding’ during busy finish periods. 
 

  2) Alternatively each athlete is given a re-usable barcoded card  
  representing their finishing position/order. The Athlete Scanner  
  is then subsequently used to scan the Athlete ID barcode and  
  associated finish position barcode for each athlete completing  
  the race. This scenario avoids the need to scan athletes   
  immediately as they finish the race, and additionally allows athletes to be scanned in 
  any order as in this case the athlete’s finishing position is determined by their Finish 
  Position barcode and not by the order in which the athletes were scanned. 
 
The RaceTime System Software. Racetime provides the following main features: 
 

  - Ability to register athlete details (ie: barcoded ID, name, gender, category and up to 4 
    additional fields) via the PC keyboard, or imported from a 
    simple CSV text file.  
 

  - Ability to download the Timer(s) and scanner(s) to load the 
  race results into the system database. 
 

  - Export facility to generate the race results including Athlete 
    name + additional details, finish positions and race times as 
    an output data file ordered by finish position. Output file  
    opens in Excel 
 

  - Athletes included in the output results may be selected using 
    any of the Registered data fields (eg: to provide separate results for Male/ Female 
    competitors) 
 

  - The output results file may be used directly, or may be passed to other systems if             
    required for further processing and/or reporting. 
 

  - The system also automatically synchronises the Timer and scanner devices. 
 

• Barcodes A range of options are available for generating the Athlete ID barcodes and finish 
position cards, from pre-printed labels, or plastic tokens or cards through to various self-print 
options. 

 
The following Sections summarise the operation of the RaceTime system in each of the possible      
operating modes (ie: Mass Start, Individual Start, Group Start). 

OPN2002 

OPN2001 

CPT8200 
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Important Note. Synchronising Timers and Scanners: 
 

Before any event we strongly recommend synchronising all scanning and timing devices.  
 

This is especially true where multiple timer/ scanner devices are being used, or for Group Start or 
Individual start events where the athlete timings will be logged by more than 1 device.  
 

To synchronise the devices see section 5.0 below. 
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1.1 Using Racetime for Mass Start Events 
 

In this case the Athlete Timer(s) and Athlete Scanner(s) will be used as summarised below. (See 
also following 2 schematic drawings): 
 
1) The Athlete Timer will be used to log the start time of the race and the finish times of athletes 

as they cross the finish line.  
 Times are logged by simply pressing the timer trigger button. Thus subsequent presses of the 
 trigger will set the start time of the event, the start time of the race itself and the finish times 
 for the 1st, 2nd, 3rd athlete etcC 
 (See Separate user guides for the Athlete Timers). 
 

 In this way the Timer will capture the race timings but will not know which athlete finished in 
 which position. This is the job of the Athlete scanner below: 
 
2) The Athlete Scanner will be used to capture the Athlete’s finishing positions as follows: 
 

  If Finishing Position barcodes are being used then the scanner will be used to scan the 
  Athlete’s ID barcode followed by the barcoded finish position from the card they were 
  handed as they finished the race. (The barcoded finish position cards will normally be 
  collected for re-use). In this case the athlete finish positions are determined by the           
  barcode on the finish position card so athletes can be scanned in any order. 
 
  If Finishing Position barcodes are not being used the scanner will simply be used to 
  scan the barcoded ID of each athlete in order as they finish the race. In this case the 
  athlete finish positions will be determined simply from the order in which the Athlete IDs 
  were scanned. 
 
NOTE: See also Section 12.4 below Using Multiple Timers & Scanners 
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1. REGISTER THE COMPETITORS 
Prior to the start of the race the competitors are registered and allocated a 
unique barcoded ID.  
Competitors may be registered directly into the RaceTime software or may be 
registered via other software and then imported into RaceTime. From a simple 
csv text file. 

2. ISSUE ATHLETE BARCODES 
Each competitor is issued with the relevant 
barcoded athlete ID (eg: self adhesive label, 
pre-printed plastic token or card etc) 

START 

3. CAPTURE RACE START TIME 
At the race starts use the Timer to capture the race start 
time (See relevant Race Timer User Guide) 

FINISH 

6. DOWNLOAD TIMERS & SCANNERS AND GENERATE RESULTS 
The Timer(s) and Scanner(s) are downloaded. Results will be                      
generated in Excel format. 

SCHEMATIC 1 
 

MASS-START Event Using FINISH POSITION BARCODES 
to Identify Athlete Finish Positions 
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5. CAPTURE ATHLETE FINISH POSITONS 
Competitor’s barocded ID and Finish Position 
card are scanned using the OPN2001 Scanner.  
 

Finish Position cards are collected for re-use. 

4. CAPTURE FINISH TIMES 
As competitors cross the line use the Athlete Timer to 
capture individual finish times (See relevant Athlete Timer 
User Guide).  
Competitors are also handed a barcoded card which                      
identifies their finishing position 
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1. REGISTER THE COMPETITORS 
Prior to the start of the race the competitors are registered and allocated a 
unique barcoded ID.  
Competitors may be registered directly into the RaceTime software or may be 
registered via other software and then imported into RaceTime from a simple 
csv text file. 

2. ISSUE ATHLETE BARCODES 
Each competitor is issued with the relevant 
barcoded athlete ID (eg: self adhesive label, 
pre-printed plastic token or card etc) 

START 

3. CAPTURE RACE START TIME 
At the race starts use the Athlete Timer to capture 
the race start time (See relevant Athlete Timer User 
Guide) 

FINISH 

6. DOWNLOAD TIMERS & SCANNERS AND GENERATE RESULTS 
The Timer(s) and Scanner(s) are downloaded. Results will be generated in 
Excel format. 

SCHEMATIC 2 
 

MASS-START Event without FINISH POSITION BARCODES  
(Athlete Finish Positions determined by scan order) 

5. CAPTURE ATHLETE FINISH POSITONS 
Scan the Athlete ID barcodes in finishing order to identify 
each athlete’s finishing position. (Finish Position cards are 
not used in this case). 

4. CAPTURE FINISH TIMES 
As competitors cross the line use the Athlete Timer to 
capture individual finish times (See relevant Athlete 
Timer User Guide).  
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1.2 Using Racetime for GroupStart Events 
 

In this case the Timer(s) and Athlete Scanner(s) will be used as summarised below. (See also            
following 2 schematic drawings): 
 
1) In this case Athletes will be started in Groups by scanning a barcode representing the group to 

which the athlete was allocated. (Thus if using groups identified as G1, G2, G3 etc. it will be 
necessary to print barcodes representing G1, G2, G3C) 

 

 Note 1: The Athlete’s Start Group is entered on their record in the Registration database. This 
 represents the athlete’s current Start Group which will be used to determine their start time 
 when processing the race results. Changing an athlete’s Start Group in future does not alter 
 their historical results) 
 

 Note 2: Athlete finishing positions will also be captured using Athlete Scanners at the end of 
 the race . It is important not to mix Athlete Start data and Finish position data in the same 
 scanner at the same time. Thus if a scanner contains Athlete Start times this scanner must be 
 downloaded before using the scanner to collect Athlete finish positions. 
 For this reason we would recommend considering the use of multiple athlete scanners when 
 operating in this mode in order to dedicate different scanners for the capture of Start data and 
 Finish data. (Practicalities rather dictate this approach for events where athletes will still be 
 starting when others are finishing) 
 
2) The Athlete Timer will be used in the usual way to log the initial start time of the race and the 

finish  times of athletes as they cross the finish line.  
 Times are logged by simply pressing the timer trigger button. Thus subsequent presses of the 
 trigger will set the start time of the event, the start time of the race itself and the finish times 
 for the 1st, 2nd, 3rd athlete etcC 
 (See Separate user guides for the Athlete Timers). 
 

 In this way the Timer will capture the race timings but will not know which athlete finished in 
 which position. This is the job of the Athlete scanner below: 
 

 Note: In this case the start time for each individual competitor is set by scanning the relevant 
 Group ID barcode (Step 1 above), and not by the nominal race start time set in the Timer.  
 For consistency with ‘Mass Start’ events however the operation of the Timer remains                     
 unchanged for ‘Group Start’ events (hence the need to use the initial trigger press to set a 
 nominal race start time. This time is however not used when calculating race results for 
 ‘Group Start ’ events)  
 
2) The Athlete Scanner will be used to capture the Athlete’s finishing positions in the usual way 

as follows: 
 

  If Finishing Position barcodes are being used then the scanner will be used to scan the 
  Athlete’s ID barcode followed by the barcoded finish position from the card they were 
  handed as they finished the race. (The barcoded finish position cards will normally be 
  collected for re-use). In this case the athlete finish positions are determined by the           
  barcode on the finish position card so athletes can be scanned in any order. 
 
  If Finishing Position barcodes are not being used the scanner will simply be used to 
  scan the barcoded ID of each athlete in order as they finish the race. In this case the 
  athlete finish positions will be determined simply from the order in which the Athlete IDs 
  were scanned. 
 
1.2.1 Generating the Group Start Barcodes 
A set of Group Start Barcodes may be generated easily in MS-WORD using a free barcode font 
(contact ERS for details of the font). 
The printed codes may be laminated to create a set of durable, re-usable cards if required. 
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1. REGISTER THE COMPETITORS 
Prior to the start of the race the competitors are registered and allocated a 
unique barcoded ID.  
Competitors may be registered directly into the RaceTime software or may be 
registered via other software and then imported into RaceTime from a simple 
csv text file. 

2. ISSUE ATHLETE BARCODES 
Each competitor is issued with the relevant 
barcoded athlete ID (eg: self adhesive label, 
pre-printed plastic token or card etc) 

START 

FINISH 

6. DOWNLOAD TIMERS & SCANNERS AND GENERATE RESULTS 
The Timer(s) and Scanner(s) are downloaded. Results will be                  
generated in Excel format. 

SCHEMATIC 3 
 

GROUP START Event using FINISH POSITION BARCODES  
to Identify Athlete Finish Positions 
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5. CAPTURE ATHLETE FINISH POSITONS 
Competitor’s barocded ID and Finish Position 
card are scanned using the Athlete Scanner.  
 

Finish Position cards are collected for re-use. 

3. CAPTURE GROUP START TIMES 
As each Group starts the event use an 
Athlete Scanner to scan the Group ID         
Barcode to log the Group start time. 
Note: The scanner cannot be used to hold Group Start Times 
and Finish Position data at the same time. Start Times must be 
downloaded before using the scanner to capture finish positions.  

4. CAPTURE FINISH TIMES 
As the competitors cross the line use the 

Timer to capture the individual finish times (See                 
relevant Race Timer User Guide). 
 

Competitors are also handed a barcoded card which 
identifies their finishing position 
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1. REGISTER THE COMPETITORS 
Prior to the start of the race the competitors are registered and allocated a 
unique barcoded ID.  
Competitors may be registered directly into the RaceTime software or may be 
registered via other software and then imported into RaceTime from a simple 
csv text file. 

2. ISSUE ATHLETE BARCODES 
Each competitor is issued with the relevant 
barcoded athlete ID (eg: self adhesive label, 
pre-printed plastic token or card etc) 

START 

FINISH 

6. DOWNLOAD TIMERS & SCANNERS AND GENERATE RESULTS 
The Timer(s) and Scanner(s) are downloaded. Results will be                  
generated in Excel format. 

SCHEMATIC 4 
 

GROUP START Event without FINISH POSITION BARCODES  
(Athlete Finish Positions determined by scan order) 

3. CAPTURE GROUP START TIMES 
As each Group starts the event use the 
Athlete scanner to scan the Group ID         
Barcode to log the Group start time. 
Note: The scanner cannot be used to hold Start Times and Fin-
ish Position data at the same time. Start Times must be 
downloaded before using the scanner to capture finish positions.  

5. CAPTURE ATHLETE FINISH POSITONS 
Scan the Athlete ID barcodes in finishing order to identify 
each athlete’s finishing position. (Finish Position cards are 
not used in this case). 

4. CAPTURE FINISH TIMES 
As the competitors cross the line use the 
Timer to capture the individual finish times 

(See relevant Race Timer User Guide). 
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1.3 Using Racetime for Individual Start Events 
 

This is really a special case a Group Start event, with each Athlete associated with their own Group.  
In this case the Athlete Timer(s) and Athlete Scanner(s) will be used as summarised below. (See 
also following 2 schematic drawings): 
 
1) In this case Athletes will be started individually by using an Athlete scanner to scan the                     

Athlete’s barcoded ID. Each competitor’s start time is set as the time their ID was scanned. 
 

 Note 1: The Start Group entered for each Athlete in the Registration database will be the 
 same as their Athlete ID. (This represents the athlete’s current Start Group which will be used 
 to determine their start time when processing the race results. Changing an athlete’s Start 
 Group in future does not alter their historical results) 
 

 Note 2: Athlete finishing positions will also be captured using Athlete Scanners at the end of 
 the race . It is important not to mix Athlete Start data and Finish position data in the same 
 scanner at the same time. Thus if a scanner contains Athlete Start times this scanner must be 
 downloaded before using the scanner to collect Athlete finish positions. 
 For this reason we would recommend considering the use of multiple athlete scanners when 
 operating in this mode in order to dedicate different scanners for the capture of Start data and 
 Finish data. (Practicalities rather dictate this approach for events where athletes will still be 
 starting when others are finishing) 
 
2) The Athlete Timer will be used in the usual way to log the initial start time of the race and the 

finish  times of athletes as they cross the finish line.  
 Times are logged by simply pressing the timer trigger button. Thus subsequent presses of the 
 trigger will set the start time of the event, the start time of the race itself and the finish times 
 for the 1st, 2nd, 3rd athlete etcC 
 (See Separate user guides for the Athlete Timers). 
 

 In this way the Timer will capture the race timings but will not know which athlete finished in 
 which position. This is the job of the Athlete scanner below: 
 

 Note: In this case the start time for each individual competitor is set by the initial athlete scan 
 (Step 1 above), and not by the nominal race start time set in the Timer.  
 For consistency with ‘Mass Start’ events however the operation of the Timer remains                     
 unchanged for ‘Individual Start’ events (hence the need to use the initial trigger press to set 
 a nominal race start time. This time is however not used when calculating race results for 
 ‘Individual Start ’ events)  
 
2) The Athlete Scanner will be used to capture the Athlete’s finishing positions in the usual way 

as follows: 
 

  If Finishing Position barcodes are being used then the scanner will be used to scan the 
  Athlete’s ID barcode followed by the barcoded finish position from the card they were 
  handed as they finished the race. (The barcoded finish position cards will normally be 
  collected for re-use). In this case the athlete finish positions are determined by the           
  barcode on the finish position card so athletes can be scanned in any order. 
 
  If Finishing Position barcodes are not being used the scanner will simply be used to 
  scan the barcoded ID of each athlete in order as they finish the race. In this case the 
  athlete finish positions will be determined simply from the order in which the Athlete IDs 
  were scanned. 



       4. CAPTURE FINISH TIMES 
                As the competitors cross the line use the 
Athlete Timer to capture the individual finish times 
(See relevant Race Timer User Guide). 
 

Competitors are also handed a barcoded card which 
identifies their finishing position 
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1. REGISTER THE COMPETITORS 
Prior to the start of the race the competitors are registered and allocated a 
unique barcoded ID.  
Competitors may be registered directly into the RaceTime software or may be 
registered via other software and then imported into RaceTime from a simple 
csv text file. 

2. ISSUE ATHLETE BARCODES 
Each competitor is issued with the relevant 
barcoded athlete ID (eg: self adhesive label, 
pre-printed plastic token or card etc) 

6. DOWNLOAD TIMERS & SCANNERS AND GENERATE RESULTS 
The Timer(s) and Scanner(s) are downloaded. Results will be                  
generated in Excel format. 

SCHEMATIC 5 
 

INDIVIDUAL START Event Using FINISH POSITION                                          
BARCODES to Identify Athlete Finish Positions 
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5. CAPTURE ATHLETE FINISH POSITONS 
Competitor’s barocded ID and Finish Position 
card are scanned using the Athelete Scanner.  
 

Finish Position cards are collected for re-use. 

START 

FINISH 

3. CAPTURE ATHLETE START TIMES 
As each Athlete starts the event use the 
Athlete Scanner to scan their barcode ID         
to log the Athlete’s start time. 
Note: The Athlete scanner cannot be used to hold Start Times 
and Finish Position data at the same time. Start Times must be 
downloaded before using the scanner to capture finish positions.  
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1. REGISTER THE COMPETITORS 
Prior to the start of the race the competitors are registered and allocated a 
unique barcoded ID.  
Competitors may be registered directly into the RaceTime software or may be 
registered via other software and then imported into RaceTime from a simple 
csv text file. 

2. ISSUE ATHLETE BARCODES 
Each competitor is issued with the relevant 
barcoded athlete ID (eg: self adhesive label, 
pre-printed plastic token or card etc) 

6. DOWNLOAD TIMERS & SCANNERS AND GENERATE RESULTS 
The Timer(s) and Scanner(s) are downloaded. Results will be                  
generated in Excel format. 

SCHEMATIC 6 
 

INDIVIDUAL START Event without FINISH POSITION BARCODES  
(Athlete Finish Positions determined by scan order) 

START 

FINISH 

3. CAPTURE ATHLETE START TIMES 
As each Athlete starts the event use the 
Athlete Scanner to scan their barcode ID 
to log the Athlete’s start time. 
Note: The Athlete scanner cannot be used to hold Start Times 
and Finish Position data at the same time. Start Times must be 
downloaded before using the scanner to capture finish positions.  

5. CAPTURE ATHLETE FINISH POSITONS 
Scan the Athlete ID barcodes in finishing order to identify 
each athlete’s finishing position. (Finish Position cards are 
not used in this case). 

4. CAPTURE FINISH TIMES 
 As the competitors cross the line use the 

Athlete Timer to capture the individual finish times 
(See relevant Race Timer User Guide). 
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1.4 Using Multiple Timers/ Scanners 
 

RaceTime Supports the use of multiple timers and scanners. 
 

The storage capacity of the devices is such that a single scanner/ timer will normally be more than 
sufficient for the size of events for which RaceTime was designed, however using multiple timers and 
scanners can provide additional functionality. For example: 
 

1) For events using Finish Position barcodes multiple athlete scanners may be used to speed the 
process of scanning athletes after finishing the race.  

 Note that multiple Athlete Scanners can also be used for events which do not use finish              
 Position barcodes – in this case the athlete finish positions are determined by the order in 
 which the athletes were scanned. If multiple athlete scanners are used the athlete finish             
 positions will also be determined by the order in which the scanners are downloaded: thus the 
 1st scanner to be downloaded will determine the athletes who finished in positions 1, 2, 3,
 C,n, with the next downloaded scanner determining athletes finishing in position n+1               
 onwards. (ie: each subsequently scanner continues from the last finish position from the   
 previous download) 
 
2) When running Mass Start events the use of 2 Timers and Scanners can also allow initial                 

results to be posted before all athletes have finished the race. This might be used for example 
to allow fast runners to obtain their times and positions before the final runners have                       
completed the course. 

 In this case it is simply a matter of switching to use the 2nd timer/ scanner when the 1st                
 devices are taken for downloading. The results of the early finishers can then be downloaded 
 to the system and posted, whilst the 2nd scanner/ timer continue to log the remaining athletes. 
 When finally downloading the 2nd devices at the completion of the race these remaining             
 results will be added to the early finishers and the full race results can be posted. 
 

 Note 1: this only fully works with Mass Start events where all competitors start at the same 
 time. With Individual and Group Start events an athlete’s final finishing position is not known 
 until all competitors have completed the race. 
 

 Note 2: When operating with 2 Timers in this way both timer devices will be setup and used in 
 the same way ie: at the start of the race all timers will be set with the race start time in the 
 usual way. 1 timer will then be used to capture the finish times of the early finishers, with the 
 2nd device being set aside for use when the 1st device is taken for downloading. 
 
When using multiple devices it is especially important to ensure that all devices are synchronised 
before the event (see section 5.0 below)  



2.0 INSTALLATION  
The RaceTime system ‘installation kit’ may be supplied on CD, Memory Stick or sent as an electronic 
download. 
 

To install the system proceed as summarised below.  
 

Note: We recommend the system be installed from an Administrative logon 
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1.  Install the OPN200X Drivers 
To install the drivers proceed as summarised below: 
 

Note: Do not connect the OPN200X onto the PC until step 2 below 
 

• Step 1 - Run the Opticon Driver Installer (USB Drivers Installer.exe) from the 
USB Drivers folder in your System Installation kit, and follow the prompts. 

• Step 2 - Connect the OPN200X to the PC. The Windows Found New Hardware 
wizard will automatically complete the driver install. 

 

 Note:  To check the driver installation open the Windows Device Manager with 
 the OPN200X device connected to the PC. Expand Ports to show a list of all 
 available communications ports on the PC. If the OPN200X has installed                 
 correctly it will be listed with a description similar to:  
  Opticon USB Code Reader (COMxx) 

3.   Install the RaceTime System Software 
To install the system software proceed as follows: 

• Run the Windows application installer Setup.exe from the PCInstall folder in the 
Installation kit, and follow the prompts. The installer will normally add an icon to 
the desktop of the PC. 

• Run the Racetime software 

• Create a new database  

2.  Optional: Install the Drivers for the Advanced Race Timer (if used) 
To install the drivers for the CPT8200 Avanced Timer proceed as summarised below: 
 

Note: Do not connect the timer onto the PC until step 2 below 
 

• Step 1 - Run the Driver Installer (CP210x_VCP_WIn2K_XP_S2K3.exe or 
CP210x_VCP_WIN7.exe) from the USB Drivers folder in your System                      
Installation kit, and follow the prompts. This installs bot ht ebasic USB drivers 
and a ‘VCP COM Port’ driver which makes the Timer look like a simple COM 
port on the PC 

• Step 2 - Once the drivers are installed connect the CPT8200 Timer to the PC, 
power up the Timer and Select Menu Option 3 (Initialise) from the Timer Menu. 
The Windows Found New Hardware wizard will automatically complete the driver 
install. Note: this can take around 30 seconds to complete 

• Step 3—Once the drivers have been fully installed you can exit from Initialise 
Mode on the terminal. 

 
 Note: If you want to 'watch' the installation process then have the Windows               
 Device Manager open during the installation above: the Timer will initially appear 
 under 'Other Devices' as 8200 USB VCOM, however once the drivers have been 
 fully installed it will then appear under 'Ports' as Silicon Labs CP210x USB to 
 UART Bridge (COMxx). You don't have to do this of course, but it can be                
 interesting to watch the process ! 
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5. RaceTime is now installed and ready to use. 

2. Click Change Licence 

3. RaceTime generates a random Keycode. 
Contact ERS for the relevant release code. 
Enter the Release Code and click OK 

1. Click Help > Licence Management 
from the RaceTime Menu bar 

5.  Register the RaceTime Software 
After initial installation the software will run in demonstration/evaluation mode where 
the max. number of records in the database will be limited. 
 

To register the software for normal a release code is required from ERS. To obtain the 
Release Code run the RaceTime software and proceed as follows:   

DEMO 

For information: The default location for the RaceTime database is: 
C:\ProgramData\Electronic Reading Systems Ltd\ERS Race Time 

4. Create the System Database 
To create the RaceTime database run the RaceTime software and proceed as follows: 

2. Click Yes to create RaceTime 
database  

1. Program splash screen displayed 
for approx 5 seconds 

3. Database is automatically created. 
RaceTime starts up by displaying Main 
Menu screen 



Electronic Reading Systems Ltd, Tel: 01234 855300 Fax: 01234 855446  Web: www.ers-online.co.uk 

3.0 CONFIGURING ERS RACETIME 
 
3.1 SETTING UP ADDITIONAL FIELD NAMES (Optional) 
When registering competitors the competitor’s barcoded ID, name, gender and race category may be 
entered, together with up to 4 additional fields (by default called AF1 - AF4) and a free text ‘Notes’ 
field. 
The Additional Fields may be used to contain for example a contact telephone number or email              
address, or other data as required. These data fields may be used when selecting a set of specific 
competitors to be included in the output results. 
To configure the names or titles of these Additional fields click Tools > Options from the program 
menu bar and from the Additional Fields Tab enter the relevant titles as required. 

3.2 SETTING UP THE EVENT NAME & DETAILS 
Before the event the event name and details must be entered onto RaceTime. Multiple events may 
be configured as required for future selection. 
 

When timing an event the event name will automatically be attached to all downloaded results,                    
enabling results from different events to be stored in the database for historical ‘reporting’. 
 

To enter details for a new event click Event >> New from the program Menu Bar and enter the re-
quired event details. Click OK to Save: 

1 

2 

3 

2) Specify the event Start types from the drop down 
list 
- Mass Start (all competitors start at the same time) 
 -Individual Start (Each competitor individually 
started)  
- Group Start (Groups of athletes started in Batches) 

3) Specify whether Finish Position Barcodes will be used to set the Athlete’s finishing position: 
Yes—position tags are being used at the finish line 
No—position tags are not being used (ie: Athletes will be scanned in their finishing order) 

Event Name, Date and Event Type are all free text fields. 
Note: the Event Name will be used as the output filename 
so reserved Windows filename characters cannot be used  



Electronic Reading Systems Ltd, Tel: 01234 855300 Fax: 01234 855446  Web: www.ers-online.co.uk 

To display the current event details at any time click Event > Event Information from the program 
menu bar: 

To select a new event as the current event, click Event > Close from the program menu bar to close 
the currently selected event, then either Event > Open to select a previously configured event or 
Event > New to configure and select a new event. 

Event > Open displays a list of all events currently           
configured in the database. 
To select one of these events as the current event 
highlight the event name in the list and click OK 

The created event will automatically be selected as the current event. 
To configure another event simply close the current event (Event >> Close) and click New to enter 
the event details. 
(Remember that the last event entered will automatically be set as the ‘current’ event by default, so 
you have configured multiple events make sure before timing an event that the correct event is              
selected before downloading the timer/ scanner devices !) 
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4.0 REGISTERING ATHLETES 
Before the event all competing athletes must be added onto the system. Athletes may be entered 
manually via the PC keyboard, or may be imported via CSV text file (Note: this import will shortly be 
expanded to also allow importing direct from Excel and to allow variable input file formats). 
 
4.1 REGISTERING ATHLETES MANUALLY 
To register athletes via the PC click Athlete Registration from the Main menu screen and                   
proceed as shown below: 

1. Click Add New to add a new athlete 

2. Enter the relevant details as required. The only mandatory fields 
are the Athlete’s Barcode ID and Surname. 
 

Note: many fields operate as self populating drop down lists. Thus 
once a gender or category etc. are entered for the first time these 
will be available as a drop down for future selection, if required. 

3. The Athlete is added to the list. Click Add New to add 
another athlete. 

Note:  To delete Athletes highlight one or 
more from the list and click Delete. 

Note -Start Group: This is used for Group Start and Individual Start 
events only: 
The Start Group currently held in the registration database for the Ath-
lete is used to determine their actual race start time.  
Note that an Athlete’s Start Group may change for subsequent events 
without altering the results for events that have already been processed 
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4.2 IMPORTING ATHLETES 
To import athletes from a CSV text file click File > Import > Athlete Data File from the program 
menu bar and proceed as shown below: 

1. Browse to the required import file and click 
Open to start the import 

2. By default the import will merge records in the import 
file with any data currently in the Athlete database 

Note:  See Appendix A for details of the import file format. 



5.0 SYNCHRONISING & DOWNLOADING THE TIMERS AND SCANNERS 
 
5.1 Synchronising the Timers and Scanners 
 

Before running any event we strongly recommend ensuring that the Timers and Scanners are 
cleared of any stored data and that their internal real-time clocks are synchronised. 
To do this click Event >> Initialise Devices from the program menu bar and then connect each of 
the devices in turn to the PC. 

1. Click Download Timers from the Main Menu 

3. The total number of athlete finish times received from the Timer and the 
number of Athlete position records received from the Scanner will be sum-
marised. These should match the number of competitors who started the 
race. 
 

When the download window shows nn Position/ Timing records 
Downloaded  the device may be unplugged 

2. To download the Timer and scanner devices simply 
connect in turn to the PC via USB  
Note: Connect only 1 device at a time. 

5.2 Downloading the Timers & Scanners 
 

To download the Timers and Scanners into the ERS RaceTime software proceed as summarised 
below. 
 

Note: After a successful download the stored data will automatically be cleared from the device and 
the device’s real-time clock will be synchronised to the current PC time 

The devices have been cleared of any ‘spurious’ 
stored data and synchronised to the PC clock. 
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Note: When downloading the Athlete scanner the               
system will warn if any unpaired athlete records have 
been received (eg: when using finish position barcodes 
this might represent a scanned Athlete ID with no                    
associated Finish Position, or Finish Position barcode 
with no Athlete ID). 
If all athletes have been scanned correctly there should 
be no unpaired records.  

Note: When downloading data from the Athlete scanner for an                
Individual Start or Group Start event RaceTime will ask for                     
confirmation whether the data being downloaded represents the            
Athlete Start scans or the finish position scans. It is important to select 
the correct type for the processing of the output results to be correct   
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6.0 GENERATING THE RACE RESULTS 
To generate the race results proceed as summarised below. 
 
Note: If any errors were noted during the download process above (eg: incorrect number of finish 
times logged by the Timer, or unmatched records from the scanners) we recommend initially gener-
ating the output results with no selection criteria. 
In this case the output data file will contain all the valid results, but will also include a list of Athletes 
who completed the race but where their finish position was not logged, together will a list of any finish 
times from the Timer which could not be matched to Athletes. (See example output files below). 
From these data it may be possible to determine the actual sequence of events. 

1. Click Generate Results file from the Main Menu 

2. Use the various database fields to select the set of Athletes required for 
the output results eg: Seniors only, Junior females only etc. 
Click Export to generate the results file 
 

Note: the event name defaults to the currently configured event. To run 
results for a historical event select the relevant event name from the drop 
down list. 

3. Browse to the required output folder and provide a name 
for the output file. Click Save to write the file. 

4. The results are printed by default as a simple csv file 
which will normally open direct in Excel. 



Example results file: 

Event name, date, category and selection criteria for output results. 

Results in finishing position order 

Example output file showing an example of mis-matched (erroneous) records: 

1 

2 

3 

1 

2 

3 

This record shows a logged finish time (finish position 5) for which no matching Athlete was scanned 

This record shows a scanned athlete (Athlete ID 10016) for whom no matching Registration record was 
found in the Athlete database. The Athlete’s time and position have been correctly logged, however no 
details (eg: name etc.) have been found in the registration database. 

This record shows an athlete scanned by the Athlete scanner at the end of the race (Athlete ID 1005), but 
where the athlete’s Finish Position barcode was not scanned.  (In this case the event was configured to 
expect Finish Position barcodes to be used) 
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Note regarding erroneous data records:  
Running results with selection criteria can mask certain error conditions, or make a test for a certain 
error condition no longer applicable so after downloading the Timers and Scanners we recommend 
outputting an initial set of race results without any selection criteria. This will allow all potential               
erroneous records to be displayed for interpretation before running results for selected groups of               
athletes. 

For further details of possible erroneous records see Appendix E 
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APPENDIX A  IMPORT FILE DATA FORMAT 
 

The Athlete registration data may be imported from a simple comma delimited (CSV) text file if                
required. 
 

Note that importing a datafile will overwrite any existing data in the database. ie: the database will be 
completely refreshed. 
 
An enhanced import function will be released shortly however at present the input data file must be in 
the format summarised below: 
 
<Athlete ID>,<Athlete Surname>,<Athlete Forename>,<Gender>,<Category>,<Start Group>, 
<Additional Field 1>, <Additional Field 2>,<Additional field 3>,<Additional field 4>,<Notes><CR><LF> 
 

Where <CR><LF> are the carriage return and line feed characters. 
 

Example import file format: 
 

A1001,Yates,Michael,Male,Senior,01201 443556 
A1002,Offley,Peter,Male,Senior,peter1234@hotmail.co.uk,,,,1st time runner 
A1004,Randolph,Gemma, Female,Junior 
A0078,Bates,Norman,Male,Senior,nbates@yahoo.com 
 

Notes:  
Only the Operator ID and surname are mandatory. 
We have included the Athlete ‘Start Group’ (See Group Start events) in the import file. In reality we 
expect this may change on an event by event basis so may not be known when importing the main 
Athlete details. Nevertheless we include the Start Group for completeness 
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APPENDIX B   BARCODE FORMAT 
In order for the system to distinguish between barcodes representing competitor/ athlete IDs and 
those representing race finish positions, the system defines a simple format for the barcodes as                      
follows: 
 Athlete IDs:  Barcode must start with the single character ‘A’ 
 Finish Positions: Barcode must start with single character ‘P’ 
 
Note: The leading characters above are only used by the system when processing the downloaded 
barcode data from the OPN2001 scanners, and are automatically stripped off before the data is 
stored in the RaceTime Database.  
This means that the leading ‘A’ is not required when entering the competitor’s ID during registration. 
(See section x.xx above). 
 

 The leading character A identifies this barcode as 
an Athlete ID.  
In this example this barcode refers to Athlete 1001 

 The leading character P identifies this barcode as a 
finish position barcode.  
Thus this barcode represents finish position 25 

*A1001* 
A1001 

ATHLETE 1001 

*P0025* 
P0025 

POSITION 25 
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APPENDIX C   CREATING A NEW DATABASE 
In addition to the automatic database creation when initially installing the software it is possible to 
‘manually’ create a database from the Database Tab under Tools > Options, as follows: 

1. From the database tab under Tools > Options 
Click Create Database 

2. Browse to the required location for the database, 
enter a database name and click Save to create. 

3. Click OK. 

4 Click Yes to make the new database the active 
database for ERS RaceTime 
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APPENDIX D   POTENTIAL DATA ERRORS  
The RaceTime system is ultimately dependent on operators using the timer and scanner devices         
correctly. 
 

In the event that erroneous data is received on download RaceTime will do its best to present those 
data records on the output report in a manner which can sensibly be interpreted. 

Note regarding erroneous data records:  
Running results with selection criteria can mask certain error conditions, or make a test for a certain 
error condition no longer applicable so after downloading the Timers and Scanners we recommend 
outputting an initial set of race results without any selection criteria. This will allow all potential               
erroneous records to be displayed for interpretation before running results for selected groups of               
athletes. 

Depending on the type of event the following error groupings are defined. The exact interpretation of 
the error for any specific data record may be slightly different depending on the exact circumstances 
however the general interpretation is summarised below: 
 
Unused Finish Timings  
This generally lists any finish timings from the timer device which have not successfully been 
matched with athletes to create a complete race record for the athlete. 
 

This might for example represent additional Finish times logged by the timer compared to the num-
ber of athletes finishing the race, or when using finish position barcodes this might result from an 
athlete being scanned without scanning their finish position barcode at the end of the race: this will 
result in RaceTime not being able to associate the correct finish time with the athlete, therby leaving 
that finish time ‘unused’. 
 
Unused Athlete Finish Scans 
This generally represents any finishing athlete scans from the athlete scanner which have not been 
successfully matched with start itme and stop time to create a complete race record for the athlete. 
This might represent a situation where too few finish times have been logged by the timer device for 
the number of athletes competing in the event, or for Individual/ Group start events may result from a 
finishing athlete for whom no start time was found. 
 
Athletes who started but have no finish position /  
Groups who started but have no finish position  
These errors are checked when processing data for Individual or Group start events and represent 
situations where an athlete was started but for whom there was no finish position found in the data-
base, or where a group was started but for whom no athletes from that group were found to finish. 


